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HP 35639A Data Viewer User's Guide
Overview

Overview

With the HP 35639A Data Viewer you can examine test results on your personal
cornputer, generate reports, and automate the printing and plotting of your data.

Examining test results

The HP 35639A Data Viewer lets you view measurement data on your PC. If the
data is on a LAN it is available to anyone with a personal computer and the
HP 35639A Data Viewer. You can examine the data, compare data from different

instruments, or compare old and new data.

The following marker types and display types allow you to examine data on your
personal computer just as on the instrument that took the data.

Markers (ten maximum):

Absolute
Relative
Peak search

Display functions:

Real

Imaginary
Magnitude

Log magnitude
dB

dBm

Intensity

Phase
Unwrapped phase
Nichols

Polar

Vector (Nyquist)
I-Eye

Q-Eye
Trellis-Eye
Symbol Table

Microsoft® is a registered trademarkof the Microsoft Corporation.
Windows™ is a trademark of the Microsoft Corporation.
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Generating reports

With the HP 35639A Data Viewer you can generate reports using your test data.
Use the Windows clipboard to "paste" your HP 35639A Data Viewer displays into
any Windows word processor.

Using the HP 35639A Data Viewer you can customize the displays to look just
the way you want. You can then save your custom configuration as a named
trace template. You can re-use the template later to save time and to give your
reports a consistent look.

Customizable display attributes:

Trace text fonts

User text fonts

Line, text, marker, and grid colors
Line widths

Line types

Grid styles

Printing and plotting
With the HP 356639A Data Viewer’s Page Mode, you can:

Create plots or prints of your data with multiple displays per page
Lay out as many displays as you want

Locate the displays on the page however you want

Annotate the page with arrows and your own text

Add a page title

Print or plot the page

Paste the page into a word processor document

You can automate the layout process by saving the page layout as a page
template. Then you can select multiple files to be automatically printed using
the template.
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Supported products
The HP 35639A Data Viewer supports the following products:

HP 3560A
HP 3562A
HP 3563A
HP 3566A
HP 3567A
HP 35665A
HP 35670A
HP 3569A
HP 3587S
HP 3588A
HP 3589A
HP 89410A
HP 89440A
HP 89441A
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Menu Bar

Menu Bar

The File menu

HP 356394 Data Viewer - [FRF.DAT]
Edit View Format Object Trace Window Help

&% BN

First level Second level Dialog boxes
File
New
Page
Trace
Open
Data... Open dialog box
Page... Open dialog box
Trace... Open dialog box
Close
Close Data Close Data dialog box
Save As
Data... Save As dialog box
Page... Save As dialog box
Trace... Save As dialog box
Graphics... Save As dialog box
Save As Default
Page
Trace
Clear
Batch Convert... Convert dialog box
Print... Print dialog box
Batch Print... Batch Print dialog box
Preferences
Freq Domain...  Frequency Domain dialog box
Exit
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Menu Bar

The Edit menu

First level Second level Dialog boxes

Edit

Undo

Copy Data
Copy Bitmap
Delete

Erase Page

The View menu

File Edit

Format Object Trace Window Help

Pol2e8

Z|aldq |:ﬂv' -1

First level Second level Dialog boxes

View

Full Page

Actual Size

Zoom... Zoom dialog box
Ruler

Tool Bar

Status Bar

page 5
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Menu Bar

The Format menu

o -' ' HP 3553 AData Vie#ef —‘[FR‘F.-DN]” .
File Edit View Object Trace Window Help
'

First level Second level  Dialog boxes
Format

Trace Font... Font dialog box
User Font... Font dialog box
Color... Color dialog box
Trace Line

Hairline

0.5 Point

1 Point

1.5 Point

2 Point

2.5 Point

3 Point

Other... Other Size dialog box
Marker Line

Hairline, etc.
Grid Line

Hairline, etc.
User Line

Hairline, etc.
Page Setup... Page Setup dialog box
Layout Traces... Layout Traces dialog box
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The Object menu

HP 356394 Data ¥iewer - [FRF.DAT]
—E le Edit View Format Trace Window Help
PoToe) [«b ] (=[]

First level Second level Dialog boxes
Object
Add
Trace
Text
Line
Move
Select
Edit... Title dialog box
Lock
Unlock

page 7
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Menu Bar

The Trace menu

e —————
=

First level Second level  Dialog boxes
Trace

Result... - Select Result dialog box
Title... Title dialog box
Draw... Draw dialog box
Grid... Grid dialog box
Overlay... Overlays dialog box
Waterfall... Waterfall dialog box
Coordinate .

Y... Y coordinates dialog box

X... X coordinates dialog box
Scale

... Y Scale dialog box

X... X Scale dialog box

Polar... Polar dialog box

Vector... Vector dialog box

Phase Center...  Phase Center dialog box
Unit

Y. Y Frequency Units dialog box

X... X Frequency Units dialog box
Marker Setup... Marker Setup dialog box
Marker Multiple... Multiple Markers dialog box
Marker Peak... Peak Markers dialog box
View/Edit SDF... View/Edit SDF dialog box

page 8
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Menu Bar

The Window menu

File Edit View Format

ol Ll#] [(¢]p ) [Z[a[«TPTvT !

HP 35639A Data Viewer -[FRF.DAT}
Object Trace

First level Second level Dialog boxes

Cascade

Tile Vertically
Tile Horizontally
Arrange Icons
Close All
Refresh

list of apen
windows

The Help menu

File

o123 AP ] [Z[a]« P 1= -

HP 35639A Data Viewer - [FRFE.DAT]
Edit View Format Object Trace Window

First level Second level Dialog boxes

Help
Help... Help system
About... About dialog box
Register... Register dialog box
Feedback... Feedback dialog box
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Toolbar - Marker Mode

Z[a[(P[~]=]

Freq Response 2:1

10

TN

Status Bar
)
&
\_____/ Add, remove, or move markers on trace.
Y
4
O
\___ Add another marker to the trace.
Y
v‘<>
\_____ Remove a marker from the trace.
3N
<P
\_____ Add or remove a multiple markers.
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Move marker left one point.

Move marker right one point.

Move marker to peak.

Move marker to next larger peak.

Move marker left to next peak.

Move marker right to next peak.

Move marker to next smaller peak.

Move marker to minimum.

File Open data.

HP 35639A Data Viewer User's Guide
Toolbar - Marker Mode
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Toolbar - Change Scale

HP 35639A Data ‘Jlewer - [FRF.DAT]
File Edit View Format Trace Window Help =

=k

Freq Response 2:1

10

baé

_ Change X or Y data scale on the trace.

j Drag the cursor to scale in both the X and Y directions.
<+»

—

Drag the cursor to scale in the X direction.

\___J Drag the cursor to scale in the Y direction.
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Toolbar - Waterfall

File Edit View Format Trace Window Help
L‘ﬂ_l Le] | |+| 125 count

Pwr Spec 1
134 count

125 count /
0.54 /
N2 /

rms [ /

/

1
I
T

0 Hz

\ Change waterfall of the trace.

) Show waterfall On/Off.

\______ Select waterfall scan range, skew & hide lines (dialog box).

« >

Select trace scan (slider).
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HP 35639A Data Viewer User's Guide
Toolbar - Page Mode

Toolbar - Page Mode

“»

& [ JA N

e i MR B B,
° : LJ ]
— - Freq Response 2:1
e B 10
1]
S| g
. AN A
- - = <
: —
2' .
2 " Mag(Lo) 3
] &
el | [+
Tool Bar
Y
VAV
NA .
\_ Add or move traces, text, or lines.
Y
\_____ Change trace, text, or line
N
\_____J Move or re-size trace, text, or line.
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Add a trace to the page.

Add user text to the page.

Add a user line (or arrow) to the page.

HP 35639A Data Viewer User's Guide
Toolbar - Page Mode
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Example Tasks

Example Tasks

The following pages contain a number of example tasks which you can use to
become more familiar with using the HP 35639A Data Viewer.

All of these examples assume that the default frequency domain is set to
Magnitude. To ensure that it is, click File, then click Preferences, then click
Frequency Domain. In the Frequency Domain dialog box, click the Magnitude
radio button. Then click OK.

Example task 1: Opening multiple files

1 Click File, then click Open, then click Data. (Another way to do this is to click
on the "open folder” button on the vertical tool bar.)

2 Select the first four files in the File Name box. To do this, click on the first
file, then hold down the Shift key while clicking on the fourth file.

You can also select the files by dragging ( holding down the mouse button while
moving the mouse) across them.

3 Add two more files which are not adjacent to the first four. To do this, hold
down the Ctrl (control) key while clicking on them. You should now have six

files highlighted.
4 Click OK.

5 Click Window, then click Tile Vertically

Your screen should look similar to the illustration on the next page.

page 16



HP 35639A Data Viewer User’s Guide
Example task 1: Opening multiple files

e HP 356394 Data Viewer ' e  BE
_Fj!e Edit View Format Trace Window Help :

FRF00.DAT bt CSPEC.DAT a8
Cross Pwr: Gyx 2:1

Freg
24 0.00045

Figure 1. Opening multiple files
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Example task 2: Using markers

Click Window, then click Close All to clear the display.

Click File, then click Open, then click Data. (Or click on the button which
has an icon of an open file.) Select the FRF.DAT file and click OK.

Click on the word "Magnitude" next to the vertical axis. This will open a
dialog box for Y Coordinates. Click on LogMag and click OK.

Be sure that the result field (above the upper left corner of the graph) shows
"Freq Response". If it is not, click on the result shown to change it.

Notice that the cursor changes to a pointing-hand shape when you point to
"Magnitude" or "Freq Response”; this indicates a "hot spot", a place where you
can click to change the display.

Notice the status bar at the bottom of the screen. When you point the cursor
to a hot spot on the display or to a button on the tool bar, the status bar gives
you a short description of what the hot spot or button does.

4

Place a marker on the trace. To do this, click the marker button (diamond-
shaped icon on the side tool bar); this displays the marker tools (buttons) on
the top tool bar. Click on the "peak marker" tool (triangle with a bar over it).
This places a marker on the peak. '
Place a second marker. This time use the "drop a marker” tool (diamond
with a curved-down arrow). The new marker it will appear at the Y-axis.
Move the new marker by clicking or dragging along the trace. Notice the
marker readout (above the the main display). The X and Y values change as
you move the marker. Move the new marker to 8 kHz.

Now your display should look similar to the illustration on the next page.

6

Click on the marker readout text for the active (moveable) marker. The text
for the active marker is bright red and is surrounded by a box. This opens a
dialog box where you can type in a new X value. Type in "10000" or "10k" (no
quotes). This is another way to move the marker.

To make a different marker active, click on its marker readout text.
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 HP35639ADataViewer  -[FREDAT]

"~ Y2.053778
¥:8003471m

0 X-8kHz
Freq Response 2:1

10

AN T~

Figure 2. Using markers

7 The marker-movement buttons on the toolbar move the marker as follows:

icon description
solid triangle pointing left marker to next peak to the left
solid triangle pointing right marker to next peak to the right
triangle pointing up marker to next higher peak
triangle pointing down marker to next lower peak

triangle pointing down, with a bar marker to minimum

triangle pointing up, with a bar marker to overall peak
hollow triangle pointing left marker one bin (one data point) left
hollow triangle pointing right marker one bin right

Experiment with these buttons to move the markers.

page 19



HP 35639A Data Viewer User's Guide
Example task 3: Advanced markers

Example task 3: Advanced markers

7

Start with the Frequency Response display as in the previous task. Click the
"double diamond" button. This opens a dialog box for Multiple Markers.

In the Multiple Markers dialog box click Remove All and OK to remove all
markers from the trace.

Click the "double diamond" button again. In the dialog box select "3 markers"
and OK. This opens a dialog box for Marker Setup.

In the Marker Setup dialog box click "peak search" and OK. This places three
markers on the trace.

Click the "double diamond" button again. In the Multiple Markers dialog box
click OK. In the Marker Setup dialog box at "Annotation" select "Minus

Mkr 1"

Click OK. This creates a marker whose readout shows its distance from
Marker 1. (Marker 1 is the marker whose readout appears highest in the list
above the display.)

Using the mouse, move the new marker to a position 2.24 kHz to the right of
Marker 1.

Your screen should look similar to the illustration on the next page.
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" HP 356394 Data Viewer - [FRE.DAT] ' T BE
ﬁ File Edit Vlew Format Trace Window Help =

¢ X:1.664 kHz Y:2.053778
0 X5.12kHz Y:1.518056
X X:7.936 kHz Y:829.978 m
+ d{:2.24 kHz dY:-1.195307
Freg Response 2:1

10

o

/ﬂ\\ /$\;

Figure 3. Advanced markers
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Example task 4: Saving a template

You can save the settings you have created to a template. You can then recall
the template later to apply the same settings to other data.

1
2
3

4

Start with the screen set up as at the end of the previous task.

Click File, then click Save As, then click Trace....

In the File Name box, type in a name for your trace (for example:
MYTRACE.TRC). Then click OK.

Click File, then click New, then click Trace. The display will show a blank
trace.

To recall the trace template: click File, then click Open, then click Trace.
Select the name of your trace file (for example, MYTRACE.TRC) , then click
OK.

To recall the data: click File, then click Open, then click Data. Select
FRF.DAT, then click OK.

Your display should now be similar to the illustration on the next page, except
that the markers will not appear.

7

Click File, then click Close to close the recalled template and display the
original trace.

You can also make your settings the default so they will appear whenever you
start your HP 35639A Data Viewer. To do this click File, then click Save As
Default, then click Trace. To restore the original defaults click File, then click
Save As Default, then click Clear.
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fﬁ Eile Edit View Format Trace Wi

o X1664kHr

0 X:5.12kHz

HP 35639A Data Viewer User's Guide
Example task 4: Saving a template

-[FRE.DAT]

—

Y:2.053778
Y:1.518056

X X:7.936 kHz Y:829978m
+ dX:2.24 kHz dY:-1.195307
Freq Response 2:1
10
o )
/ \\ /B\T

Figure 4. Saving settings to a template
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Example task 5: Overlaid traces

[o—

Start with the screen set up as at the end of the previous task.

Click on the result field (currently "Freq Response™), this opens the Select
Result dialog box. In the Result box, select Output Power. Then click Add
Overlay. Then click OK.

Click on the "drop a marker” tool (diamond with a curved-down arrow) to
add a marker to the new trace, at 0 kHz. Use the mouse to move the marker
along the trace to 4 kHz.

Click on the result field for "Freq Response". If the marker readout for the
relative marker ("+ dX: 2.24 kHz") is not already active, click on it to make it
active. (The active marker text is shown by a box around it.) Use the mouse
to move the "+" marker along the trace. This is how you can select an active
trace and active marker.

Your screen should look similar to the illustration on the next page.

Notice that a box around the result field shows which of the two traces is active.
Also the bright red marker readout text and a box surrounding the marker text
show which marker is active for each trace.
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HP 35639A Data Viewer User's Guide
Example task 5: Overlaid traces

2

ms

Y

W/W& AL

(
P

Figure 5. Overlaid traces
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Example task 6: The waterfall display

1 Click Window, then click Close All to clear the display.

2 Click File, then click Open, then click Data. Select the WFAL1.DAT file, then
click OK.

3 Click on the waterfall tools button (the icon is a graph with multiple lines).
This makes the waterfall tools available.

4 Click on the toggle button (the "light switch" icon) to show the waterfall
display.

The next three steps show an example of changing the skew angle.

5 Click the "Waterfall dialog box" button. This is the button just to the right of
the toggle button.

6 Inthe Waterfall dialog box select "Skew", then change the angle from 15 to 30
(degrees). Then click OK. Notice how the display changes to show the new
skew angle.

7 Repeat the previous steps to return the skew angle to 15 degrees.

The next three steps show an example of changing the baseline.

8 Click the "Waterfall dialog box" button.
9 In the Waterfall dialog box select "Trace", then change the baseline from 0 to
20 (percent). Then click OK. Notice how the display changes.
10 Repeat the previous steps to return the baseline to 0.

The next three steps show an example of changing the annotation on the
waterfall display.

11 Click the "Waterfall dialog box" button.

12 In the Waterfall dialog box select "Annotation". Then click on the check box
labeled: "Tick Marks". Then click OK. Notice how the display changes.

13 Repeat the previous steps to turn off tick marks.
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The next three steps show an example of using markers with the waterfall
display.

14 Click the Marker Tools button (small diamond) to display the marker tools on
the upper toolbar.

15 Click the double-diamond button to open the Multiple Markers dialog box.
Click OK to add one marker. This opens the Marker Setup dialog box. Click
the "Peak Search" checkbox and click OK. The marker appears on the
display and marker readout text appears above the display.

16 Use the slide bar in the upper tool bar to move the marker to different scan
lines. Set the slider so that the reading to the right of the bar reads: "130
count".

Your screen should look similar to the illustration below.

HP 356394 Data Viewer -[WFAL1.DAT]
File Edit View Format Trace Window Hel

o 130 count X13.568 kHz Y:501.5675 mvA2
Pwr Spec 1

Figure 6. Waterfall display
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Example task 7: Generating a report

Click Window, then click Close All to clear the display.

Click File, then click Open, then click Data. Select the FRF.DAT file, then
click OK.

Add three peak markers. To do this click the marker tools button (single
diamond), then click the multiple markers tool (double diamond). In the
Multiple Markers dialog box select "3 markers" and click OK. In the Marker
Setup dialog box select "Peak Search" and click OK.

Change the size and typeface of the text on your display. To do this click
Format, then click Font, then select Font style Bold and Size 14 (points).
Then click OK.

Change the color of the marker symbols and marker readout text for the
inactive markers. To do this click Format, then click Color. In the Colors
dialog box, click the radio button for "Inactive Mkr". Change the color to
black by sliding all three color sliders to zero (that is, to the bottom of the
bar). Notice the "Color" box which shows the resulting color. Click OK.
Add a title to your graph. To do this click Trace, then click Title. In the Title
dialog box, click the "User" radio button. Then click in the "User Title" box
and type in a title for your graph (for example: My Report). Click OK.

Change the color scheme to optimize colors on your printer. Click Format, then
Color to open the Colors dialog box. For a color printer, click Color Schemes
box and select Color Printer. For a black-andwhite printer, click Color Schemes
box and select Monochrome.

7

Change the Y-axis annotation from the left to right side. To do this click
Trace, then click Grid. In the Grid dialog box, in the "Y Annotation" group of
radio buttons, click "Right Side". Then click OK.

Copy your graph to the Windows Clipboard and paste it into a word processor
document. To do this click Edit, then click Copy Graphics; this copies your
display to the Clipboard. Open any Windows-compatible word processor (for
example Microsoft® Write™. In the word processor press Ctrl-V on the
keyboard to paste the contents of the clipboard into the word processor
document.

Your screen should look similar to the illustration on the next page, depending
on how you set up your HP 35639A Data Viewer and word processor windows.
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o= HP 35639A Data Viewer - [FRF.DAT] v|s
=| File Edit Yiew Format Trace Window Help 2
Pelol®) 4] [Z[o [« [v]=]
¢ X:1.664 kHz Y:2.053778
_: 0 X5.12kHe Y:1.518056
— % X7.936 kHz Y:829.978m
L Freq Response 2:1
1 24 ,
= a\ = e
— \ Ele Edit Find Character Paragraph D t_Help
+
© X:1.664 kHz Y:2.053778 (]
OXS5.12kHz Y:1.518056 »
/ X X7936 kHz Y829.978 m
\ Freq Resp 21
Magnitade 24
\
7 yaa
NI TN
Mo, q > o
\\
-0.6
0 Hz -0.6
Status Bar 0 Hz 12.8 kHz
F
[+]
I—T D

Figure 7. Generating a report

Return to the HP 35639A Data Viewer and experiment with other ways to
change your display. In the Format menu, try Font, Colors, Trace Line, Marker
Line and Grid Line. In the Trace menu, try Title, Draw, and Grid.
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Example task 8: Using Page Mode

DN —

VL]

Click File, then click New, then click Page.

Click Format, then click Layout Traces. In the Layout Traces dialog box,
select Rows: 2 and Cols (columns): 2. Then click OK.

Click View, then click Full Page to see the entire page on the screen.

Click File, then click Open, then click Data. Select the FRF.DAT file and
click OK.

The data is now shown in the first display. Also, all of the measurement results
in the data file FRF.DAT are available to all the displays on the page.

5

6

Click on the word "Magnitude" next to the vertical axis. This will open a
dialog box for Y Coordinates. Click on LogMag and click OK.

On the upper-most display on the right-hand side of the page, click on the
word "Empty" just above the graph. This will open the Select Result dialog
box. Click on the word "Empty” in the Result box and select "Freq Response”
from the list. Then click OK.

Click on the word "Magnitude" next to the vertical axis. In the Y Coordinates
dialog box, click on "Phase". Then click OK.

On the lower display on the left-hand side of the page, click on the word
"Empty”". Inthe Select Result dialog box, replace "Empty" with "Coherence”.
Then click OK.

On the lower display on the right-hand side of the page, replace "Empty”
with "Cross Power". ‘

Your screen should look similar to the illustration the next page.
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o B .  HP 35639A Data Viewer - [FRF.DAT]

Figure 8. Using page mode

page 31



HP 35639A Data Viewer User's Guide
Example task 9: Adding Annotation

Example task 9: Adding Annotation

You can add annotation only in Page Mode.

1
2
3

4

Start with the Page display as in the previous task.

Click on View and click on Actual Size to turn off Full Page view.

Click on the "add or move..." button (the icon is a graph with an arrow and a
letter "A").

Click on the "add a user line" button (a downward-pointing arrow). Then
drag the mouse cursor to draw an arrow pointing to the trace in the
upper-left display.

If you wish to delete an annotation (arrow or text) that you have added to the
display: click on the item to select it, then click Edit and Delete (or press the
Delete key on the keyboard).

5

Add text to your display. To do this click on the "add user text" button (the
iconis the letter "A"). Then drag the mouse on the display to create a text
box. Double-click in the text box (or press Enter) to open the Text dialog
box. Type in a line or two of text (for example "This is a trace."). Then click
OK. If necessary use the "move or re-size..." button (the icon is an open
hand) to stretch the text box to display all of your text. To stretch the text
box, place the cursor on one of the eight "handles" of the box and drag the
handle with the cursor.

Move the text to the line up with the arrow you created earlier. To do this,
click on the "move or re-size..." (hand) button, then use the hand-shaped
cursor to drag the text box to the position you want.

Change your user text to italic typeface. To do this click Format and User
Font. In the Font dialog box change "Regular” to "Italic". Then press OK.

Your screen should look similar to the illustration the next page.

Experiment with adding more annotations to your display.
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Figure 9. Adding annotation
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Example task 10: Batch printing

1

7

8

Click Window, then click Close All to close all previous windows. Click File,
then click New, then click Page to set up a new page. Click View and Full
Page if necessary to see the entire page.

Click Format, then click Layout Traces. In the Layout Traces dialog box,
type in a page title (for example: "This is a Title"). Leave the trace layout at
3 rows and 2 columns. Then click OK.

Click Format, then click Colors. In the Colors dialog box click the Color
Schemes box and select Monochrome. This select a black-and-white color
scheme.

Click File and Batch Print. In the Batch Print dialog box select FRF.DAT and
click OK.

In the second Batch Print dialog box, select the List radio button and click
the Select button. This opens the Select Result dialog box which includes a
list of measurement results listed by number. To see the corresponding
results for your data file listed by name, click From File and click FRF.DAT.
Then click OK. '

On the list of results click Freq Response, Coherence, Input Power, and Cross
Power. The dialog box now indicates that your selected list is "List: 0:2,4".
That is: results 0 thru 2, and result 4. Click OK to close the Select Result
dialog box.

Back in the Batch Print dialog box, in the "Channels" group of radio buttons,
click First. Click OK to close the Batch Print dialog box.

In the Print dialog box, click OK to start the batch print.

Your print-out should look similar to the illustration the next page.
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Figure 10. An example of batch printing
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Example task 11: Using polar plots

1 Click Window, then click Close All to clear the display.

2 Click File, then click Open, then click Data. Select the FRF.DAT file, then
click OK. ,

3 Click the Y-axis coordinate ("Magnitude"). In the Y Coordinates dialog box,
select Polar. Then click OK.

4 Click Trace, then click Draw. In the Draw dialog box, click "Z annotation".
Then click OK.

5 Click the Marker Tools button. Then click the marker "double-diamond"
button. In the Multiple Markers dialog box, click OK. In the Marker Setup
dialog box, click the "X" box and type in "5120". This sets the X value of the
markers to 5.12 kHz. Click OK.

6 Click Trace, then click Scale, then click Polar. In the Polar Scale dialog box,
click "Marker" (in the Center section) and click the "Offset data"
checkbox.scale. Click OK.

Your screen should look similar to the illustration on the next page.

page 36



HP 35639A Data Viewer User's Guide
Example task 11: Using polar plots

HP 35639A Data Viewer - [FRF.DAT]

o MO
Freq Response 2:1

-6.847458
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